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1 ABOUT THIS MANUAL

About this chapter

This chapter provides the following information:

■ Who should read this manual‚ page 1
■ ILRIS-3D user documentation‚ page 1
■ Organization of this manual‚ page 2
■ Notice formats‚ page 3
■ Type conventions‚ page 3.

Who should read 
this manual

This manual outlines everything you need to know to program, use and maintain 
Optech's ILRIS-3D laser scanner.  It is intended for surveyors, engineers and others 
who are familiar with survey procedures.  It is also intended for data processors 
working with ILRIS-3D data.

This manual assumes that you are:

■ Qualified and trained on ILRIS-3D, having completed an Optech training 
course

■ Familiar with the technical concepts underlying ILRIS-3D.

ILRIS-3D user 
documentation

Optech documentation is delivered as printed manuals, in Adobe Acrobat PDF 
format, and as online help where applicable.
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Organization of 
this manual

This manual consists of the following chapters:

1.  About This Manual
Basic information about this manual

2.  Getting started
Initial product setup, installing and registering software, 
shipping list

3.  Handling and safety
Handling the scanner, laser eyesafety

4.  Product overview
Scanner, pan/tilt option, batteries, cables, software, specifica-
tions, figures

5.  Setting Up at a Survey Site
Site selection tips, typical setup workflow

6.  Pocket PC Operation
Menus, windows, options and workflow for using the ILRIS-3D 
Controller software on a Pocket PC

7.  PC Operation
Menus, windows, options and workflow for using the ILRIS-3D 
Controller software on a PC

8.  Parser Operation
Menus, windows, options and workflow for using the ILRIS-3D 
Parser software

9.  Maintenance and support
Recharging batteries, cleaning windows, calibration, storage, 
warranty, customer support, returning equipment

Appendix A:  Glossary
Brief definitions of terms appearing in this manual

Appendix B:  Error Codes
Brief definitions of error codes
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Notice formats To highlight important information, this manual uses the following signal words.  Do 
not proceed until you understand the information and have complied with any 
instructions:                     

Type conventions This manual uses the type conventions outlined in Table 1.

Danger/Caution
Potential for minor or moderate injury;  unsafe practices.

Notice
Damage to equipment or loss of data;  policy on safety of personnel or 
protection of property.

Important
Important information.

Note
Useful information.

Tip
Programming, operation or maintenance suggestion.

!

!

!

!

!

Table 1:  Type conventions

Text Type Example

Hardware labels Sans-serif text POWER

Operator interface text Bold text Load Plan

Folders and filenames Monospace text C:/Program Files
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2 GETTING STARTED

About this chapter

This chapter provides the following information:

■ Overview of getting started‚ page 5
■ Unpacking your ILRIS-3D‚ page 6
■ Software system requirements‚ page 7
■ Installing the ILRIS-3D Controller‚ page 7
■ Installing the ILRIS-3D Parser‚ page 8
■ Installing PolyWorks (option)‚ page 8
■ Installing Kubit (option)‚ page 9.

Most ILRIS-3D hardware is shipped, stored and transported to the survey site in the 
Pelican carry case.  The iPAQ Pocket PC and any third-party software are shipped 
with the carry case but not inside it.  For more information, contact your Optech 
representative.

Overview of 
getting started

When you first receive your ILRIS-3D, carry out the following steps:

1. Unpack ILRIS-3D (page 6).  Check all hardware, and prepare the iPAQ Pocket 
PC for operation.

2. Charge the ILRIS-3D batteries (page 123).  Batteries are not charged before 
shipping.

3. Install the ILRIS-3D Controller and Parser (page 7 and after).

4. Install and register all third-party software, such as PolyWorks, TexCapture or 
Kubit (page 8).
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Unpacking your 
ILRIS-3D

To unpack ILRIS-3D:

1. Upon receiving your ILRIS-3D, inspect the shipping carton for external damage 
that may have occurred during transit.  If you find damage, file a claim with the 
carrier and notify your Optech representative immediately.

2. Open the carton and the carry case(s) inside, and check all items in the 
shipment against the packing list.  If any items are missing or damaged, contact 
your Optech representative.  To return equipment, see page 130.

3. Check all scanner windows and screens to ensure that they are clean and not 
cracked or scratched.  For cleaning instructions, see page 128.

4. Prepare the iPAQ Pocket PC for operation, using the iPAQ product documenta-
tion.

5. Charge the batteries with the battery charger (page 123).  Batteries should 
always be charged and ready for a survey.

Figure 1:  Unpacking the ILRIS-3D carry case

Caution    Scanner handling
The scanner weighs 13 kg and contains delicate electronics.  Before 
removing it from the carry case, see "Handling and Safety"‚ page 11.

!
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Software system 
requirements

The ILRIS-3D Controller and Parser have the following recommended requirements:

■ Windows NT/2000/XP operating system
■ 600 MHz Intel Pentium III processor or higher
■ 1 GB RAM
■ 1 GB free disk space
■ OpenGL-compatible video card.

Each data file being processed requires an equal amount of disk and swap space:  
for example, a 400-MB file requires 400 MB of disk space and 400 MB of swap 
space, for a total of 800 MB.

For third-party software requirements, see the applicable product documentation.

Installing the 
ILRIS-3D Control-
ler

The Controller software is used to program, monitor and control ILRIS-3D.  It is 
provided on the ILRIS-3D CD in two formats:  for the hand-held Pocket PC and for 
Windows PC.  The Controller is automatically pre-registered on your behalf.

To install the Controller on your Pocket PC

See your Pocket PC and computer documentation to complete the following steps:

1. Insert the ILRIS-3D CD onto your computer.

2. Connect the Pocket PC cradle to your computer via the USB cable.

3. Install the Pocket PC in the cradle, and start the device.  Wait until the connec-
tion icon appears on your computer.

4. Browse to the Controller folder on the CD, and copy the folder to your 
desktop on the Pocket PC.

5. Wait until the Pocket PC has finished converting the files to its own format.

6. To confirm that the Controller is correctly installed, browse to the Controller on 
the Pocket PC, and open it.

7. Disconnect the cradle and USB cable from your computer.

8. Remove the ILRIS-3D CD from your computer.
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To install the Controller on your computer

1. Insert the ILRIS-3D CD into your CD drive.

2. Browse to the Controller folder on the CD.

3. Click and drag the Controller.exe file to your desktop.

4. Remove the ILRIS-3D CD from your computer.

Installing the 
ILRIS-3D Parser

The Parser is used after a survey to pre-process ILRIS-3D survey data.  The Parser 
software is provided on the ILRIS-3D CD, and is automatically pre-registered on 
your behalf.

To install the Parser on your computer

1. Insert the ILRIS-3D CD into your CD drive.

2. On your desktop, create a folder called Parser.

3. On the CD, browse to the Parser folder, and double-click the 
Parser_rls.exe file.

4. Click the Browse button to navigate to the folder you created.

5. Click the Unzip button to extract the files to the specified folder.

6. Remove the ILRIS-3D CD from your computer.

Installing 
PolyWorks 
(option)

To install PolyWorks, see the product documentation.  Please register this product to 
receive software updates and technical support.

The PolyWorks software package includes a hardware dongle.  Optech records your 
dongle ID number before shipment, and registers PolyWorks on your behalf.  If we 
do not have your contact information, we will request it through your distributor.
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Installing Kubit 
(option)

To install Kubit, see the product documentation.  Please register this product to 
receive software updates and technical support.

Before you can use Kubit, your product must be registered.  Optech records your 
dongle ID number before shipment, and registers Kubit on your behalf.  If we do not 
have your contact information directly, we will request it through your distributor 
and send this information and the dongle ID to Kubit on your behalf.
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3 HANDLING AND SAFETY

About this chapter

This chapter provides the following information:

■ Handling the scanner‚ page 11
■ Handling the optional pan/tilt base‚ page 12
■ Laser safety‚ page 13
■ Hazard labels‚ page 14.

Handling the 
scanner

The scanner contains delicate electronics that are calibrated at the factory.  Always 
handle the scanner carefully as follows:

1. When the scanner is powered, do not lay it on its side.

2. Do not touch the front scan window.

3. Do not immerse the scanner.  The scanner is water/dust-proof to NEMA 4X.

4. Do not open the scanner.  There are no user-serviceable parts inside.

5. The scanner is heavy.  Lift and move it with care, and do not drop it.

Opening the scanner will void the ILRIS-3D warranty.

Figure 2:  ILRIS-3D Scanner
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Preventing the scanner from overheating

If the scanner overheats, it will shut down.  To keep the scanner within its operating 
temperature range of 0 to 40°C:

■ Protect the scanner from direct sunlight by shading it under an umbrella, 
tent or other awning

■ Cover the scanner with a cool, damp cloth.

The scanner temperature is displayed on the Controller interface (page 51, page 86).

Handling the 
optional pan/tilt 
base

Figure 3:  Pan/tilt base

When handling the pan/tilt base:

■ Do not put your fingers into the holes on top of the platform
■ Do not put your fingers between the motorized platform and the base 

below it.

Danger    Heavy weight and pinching hazard
Make sure that the scanner is leveled on the tripod, and that the tripod is 
set up securely, to prevent the scanner from tipping over as it rotates.

Keep hands and fingers away from the top and sides of the pan/tilt base 
when ILRIS-3D is powered.

!
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The pan/tilt base includes a locking pin that, when inserted, prevents the scanner 
from swinging up and back past the base’s mechanical limits, and protects pan/tilt 
gears from strain when lifting and moving the scanner.  Always keep this pin 
inserted except during survey operation, as shown in Figure 4.

Figure 4:  Locking pin inserted (left) and removed for operation (right)

Laser safety

The ILRIS-3D scanner is designed as a Class I laser product.  The laser radiation from 
the scanner window is completely eyesafe, even when using binoculars and looking 
directly into the window.

ILRIS-3D incorporates a Class 3b laser (IEC).  Removing scanner panels therefore, 
under certain conditions, gives access to emission levels in excess of Class 1 eyesafe 
limits.  Removing the panels may increase eye hazard.

Danger    Possible laser hazard
If the scanner is powered with its panel removed, under certain condi-
tions laser radiation may exceed Class 1 eyesafe limits.

Notice    Class I laser product
Complies with IEC 60825-1, Amendment 2 and FDA performance 
standards for laser products except for deviations pursuant to Laser Notice 
No. 50, dated July 26, 2001.

!
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Do not remove the scanner panels.  Opening the scanner will void the warranty, 
and there are no user-serviceable parts inside.

Hazard labels The following labels and tags are attached to ILRIS-3D.

Figure 5:  Laser Class 1 label

Figure 6:  Laser caution label

Figure 7:  Pinching hazard label on the optional pan/tilt base

Table 2:  Incorporated laser specifications

Parameter Specification

Wavelength 1535 nm

Pulse width <10 ns

Pulse energy <10 μJ

Average power <100 mW
14 0040170/Rev A/Nov 06



ILRIS-3D Operation Manual Handling and Safety
Figure 8:  Tag for locking pin on the optional pan/tilt base (both sides)
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4 PRODUCT OVERVIEW

About this chapter

This chapter provides the following information:

■ Figures‚ page 18
■ Scanner‚ page 19
■ Pan/tilt base (option)‚ page 20
■ Pocket PC‚ page 21
■ ILRIS-3D Controller software‚ page 21
■ ILRIS-3D Parser‚ page 22
■ Third-party software (option)‚ page 23
■ Battery equipment‚ page 24
■ Carry case‚ page 24.

ILRIS-3D is an integrated laser scanner designed for commercial surveying, with 
digital image capture and sophisticated software tools.  Its main components are 
described in this chapter.

Figure 9:  ILRIS-3D scanner on tripod
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Figures

Figure 10:  Scanner rear panel, showing LCD display panel and controls

Figure 11:  ILRIS-3D standard items, showing carry case with (from left to right) 
battery charger, battery pack, scanner, USB memory device and Pocket PC
18 0040170/Rev A/Nov 06
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Scanner The scanner is the ILRIS-3D sensor.  It includes a laser, optics, a precision X-Y 
scanner and an on-board microprocessor.  In operation the scanner accepts 
operator commands, scans the survey scene, and captures and records laser point 
data.

Survey data is typically stored on a 512-MB USB memory device.  A memory device 
is provided with ILRIS-3D.

The scanner front panel (Figure 12) houses the scanner window and a second, 
smaller window for the digital camera.  Laser pulses are emitted from the scanner 
window.

The scanner rear panel has the following features (Figure 10, page 18):

■ 17-cm LCD VGA viewfinder (640 x 480 pixel), with text panel for status 
messages

■ USB port to store scan data on USB memory devices
■ Wireless LAN and serial data connections
■ Ethernet jack for network capability
■ Battery connection.

For scanner handling information, see page 11.

Figure 12:  Scanner front panel, showing inset camera lens

Scanner base plate

The scanner base plate has a central hole for tripod installation.  It also includes two 
level bubbles at diagonal corners of the base, so that you can easily level the tripod 
if necessary (Figure 10, page 18).  The base plate is designed to latch into the 
optional pan/tilt base.
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Pan/tilt base 
(option)

The optional pan/tilt base provides 360° operation.  The base has a central hole for 
tripod installation, and is transported in a separate carry case.

The base has the following controls (Figure 13):

Red button
Opens pan/tilt base, tilting scanner up.

Green button
Closes pan/tilt base.

Locking pin
Protects pan/tilt gears from strain when lifting and moving the 
scanner.  Always remove this pin before operation, and re-
insert it afterwards.  For more information, see "Handling the 
optional pan/tilt base"‚ page 12.

Power plugs (2)
Connect from battery holder to base, and from base to scanner.  
Connectors can be attached to either plug.

Serial communication port
Connects to scanner communication port.

For pan/tilt handling information, see page 12.

Figure 13:  Pan/tilt base with scanner at different pan and tilt angles
20 0040170/Rev A/Nov 06
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Pocket PC ILRIS-3D is typically programmed and controlled by a Hewlett Packard iPAQ 4470 
Pocket PC.  The ILRIS-3D Controller software is pre-installed on this device.  The 
Pocket PC is a wireless device that communicates with the ILRIS-3D scanner.

Figure 14:  Pocket PC display, showing ILRIS-3D Controller main screen

ILRIS-3D Control-
ler software

The Controller program provides a graphical real-time display of ILRIS-3D scan 
settings and operation (Figure 15).  You can use the Controller to:

■ Capture images from the ILRIS-3D camera
■ Program a scan, defining and adding regions of interest (ROI)
■ Start and stop a scan
■ Monitor the scanner hardware
■ Monitor the progress of a scan.

The Controller is designed for both a Windows NT/2000/XP environment and a 
Pocket PC platform.

See also:

■ For a description of the Controller interface, see "PC Operation"‚ page 63.
■ For installation details, see "Installing the ILRIS-3D Controller"‚ page 7. 
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Figure 15:  ILRIS-3D PC Controller main screen (PC)

ILRIS-3D Parser The Parser processes a compressed metafile of ILRIS-3D scan data so that is suitable 
for processing by CAD, GIS or other modeling software.  The Parser is designed for a 
Windows NT/2000/XP environment.

You can use the Parser after a survey to:

■ Process survey scan data
■ Output data files that are suitable for standard GIS, CAD and modeling 

software.

Parsing is quick, flexible and easily repeated.  You can:

■ Process and re-process a scan as often as you want
■ Change Parser settings at any time
■ Select all output options without slowing parsing significantly
■ Create as many output files as you want
■ Re-parse the same scan data later with different settings.
22 0040170/Rev A/Nov 06
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See also:

■ For system requirements and installation details, see Installing the ILRIS-3D 
Parser‚ page 8.

■ For a description of the Parser interface and to use the Parser, see Parser 
Operation‚ page 97.

Main features of the Parser

■ Many output formats

■ Data reduction, to reduce data density and overall file size

■ Easy and fast re-parsing with new settings

■ Applies calibration

Figure 16:  ILRIS-3D Parser main screen

Third-party 
software (option)

ILRIS-3D provides optional third-party software to assist in the visualization, pro-
cessing and photo-draping of ILRIS-3D survey data.  PolyWorks, TexCapture and 
Kubit software are currently offered.
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Battery 
equipment

ILRIS-3D uses the following battery equipment, as shown in Figure 17:

Battery
Hytron 120 14.4-volt, 100-Whr, nickel metal hydride batteries 
(2-4 batteries).  Optech may supply equivalent batteries.

Holder
Quad battery holder, Logic Series Gold Mount

Charger
2722 dual battery PowerCharger

Cable
Power cable from the quad holder to the rear panel of the 
ILRIS-3D scanner.

The ILRIS-3D scanner is normally powered by two or four high-capacity batteries.  
Since the power consumption of ILRIS-3D is typically 80 W, a pair of fully charged 
batteries, connected in series, lasts for approximately 2 hours of survey operation.  
By using four batteries connected in series and in parallel, you can increase 
operation time to up to 4 hours.

All battery equipment is manufactured by Anton/Bauer, Inc.  For information on the 
batteries, see also:

■ "Recharging batteries"‚ page 123
■ Battery manuals provided with ILRIS-3D
■ Manufacturer’s website, www.antonbauer.com.

Figure 17:  ILRIS-3D battery charger (left) and holder (right)

Carry case ILRIS-3D is packaged for easy transport, with all essential components fitting inside 
a rugged Pelican carry case.
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5 SETTING UP AT A SURVEY SITE

About this chapter

This chapter provides the following information:

■ Overview of setting up‚ page 25
■ Before choosing a survey site‚ page 26
■ Setting up ILRIS-3D at a survey site‚ page 27
■ Setting up the optional pan/tilt base‚ page 29.

Overview of 
setting up

Setting up ILRIS-3D consists of the steps outlined in the flowchart in Figure 18.

  

Figure 18:  Setting up ILRIS-3D (flowchart)
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Before choosing a 
survey site

When selecting a survey site, consider the following issues:

Geo-referencing
ILRIS-3D creates an independent point cloud of the data 
gathered during a scan.  To geo-reference a data set, you need 
only three visible points in one scan, with the other scans over-
lapping,  OR  three visible points in all the scans, with the 
scans aligned.

Tripod leveling
Not required;  rough leveling is sufficient.  The ILRIS-3D 
scanner does not have to be set up over known points.

Moisture
The scanner is splash-resistant, but not designed to withstand 
heavy rain.

Temperature
ILRIS-3D will operate in temperatures from 0°C to 40°C.  
Batteries lose power when they are cold.  At low temperatures, 
keep the Pocket PC in a warm place such as your jacket 
pocket.

Direct sunlight
ILRIS-3D uses an embedded, high-resolution digital camera for 
targeting.  As with any camera, its settings need adjustment 
when in direct sunlight.

Working range
The working range of the Pocket PC is 7.6 m (25 ft.).  Stay 
within this range when sending commands to the scanner.

Obstructions
Wire fences, thin vegetation and moving obstructions such as 
birds and pedestrians can be edited out in data processing, and 
do not interfere with normal operation.  Larger, more 
permanent obstructions cannot be edited out, and will interfere 
with data collection.

Tripod
To prevent any movement during the scan, use a suitably rigid 
tripod (wood, fiberglass).  On smooth surfaces where tripod 
legs may slip, use a stabilizing ring.  Avoid deep snow and 
loose ground or sand.

CONSIDER THE
ISSUES BEFORE

CHOOSING A SURVEY
SITE

SET UP ILRIS-3D AT A
SURVEY SITE

OVERVIEW

CHOOSE A SURVEY
SITE
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Setting up ILRIS-
3D at a survey 
site

  

This procedure assumes that you are using the Pocket PC and scanner with a 
wireless connection:

1. Set up the tripod at a suitable location.  On smooth surfaces, use a stabilizing 
ring to prevent the legs from slipping.

2. (Option)  Set up the pan/tilt base (page 29).

3. Mount the ILRIS-3D scanner on top of the tripod interface.  The scanner base 
plate has a blind, threaded, 5/8-11 UNC mounting hole with a maximum 
insertion depth of 12.5 mm (approximately 0.5 inches).  

4. Clean the scanner window and display screen, if necessary.

5. Insert at least two batteries into the battery holder in a T-junction format 
(Figure 19).  If the holder has a switch, check that the switch is not set to 
CAMERA.

Figure 19:  ILRIS-3D batteries in T-junction format

6. Connect the battery cable from the quad battery holder to the circular jack on 
the scanner rear panel.  ILRIS-3D boots up, and the Optech splash screen 
appears on the scanner LCD display.

Notice
Handle the scanner with care.  Do not touch the front window.

Notice
Do not exceed the threaded engagement of 12.5 mm.

CONSIDER THE
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CHOOSING A SURVEY
SITE

SET UP ILRIS-3D AT A
SURVEY SITE

OVERVIEW

CHOOSE A SURVEY
SITE

!
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7. While ILRIS-3D boots up, check the scanner LCD display.  Confirm that an 
image of the survey scene appears, as well as status information.

8. Insert the USB storage device into the slot on the scanner rear panel (Figure 10, 
page 18).

9. (Option)  If you are using a laptop computer, connect the Ethernet cable from 
the laptop to the jack on the scanner rear panel.

10. Aim the scanner at the area you want to scan.

After setting up the scanner, you must configure the Pocket PC’s network settings 
(page 35).  If you are using a laptop computer instead, see "Configuring PC network 
settings"‚ page 65.
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Setting up the 
optional pan/tilt 
base

1. Mount the pan/tilt base on top of the tripod (Figure 20).
 

Figure 20:  Mounting the pan/tilt base on top of the tripod

2. Secure the pan/tilt base to the tripod, using the knob at the bottom of the tripod 
(Figure 21).

Figure 21:  Securing the pan/tilt base to the tripod 

Caution
Make sure that the scanner is leveled on the tripod, and that the tripod is 
set up securely, to prevent the scanner from tipping over as it rotates.

Handle the scanner with care.  Do not touch the front window.

!
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3. Remove the locking pin from the pan/tilt base (Figure 22).

Figure 22:  Removing the locking pin from the pan/tilt base

4. Pull the lever outwards to prepare to mount the scanner (Figure 23).

Figure 23:  Pulling the lever out from the pan/tilt base
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5. Mount the ILRIS-3D scanner to the pan/tilt base, and secure it by swinging the 
lever back into place (Figure 24).

Figure 24:  Securing the scanner to the pan/tilt base

6. Connect the power/interconnect cable from the scanner to the pan/tilt base 
(Figure 25).

Figure 25:  Connecting the power/interconnect cable to the scanner and base
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7. Connect the battery power cable to the quad battery holder (Figure 26).

Figure 26:  Connecting the power cable to the quad battery holder

8. Connect the battery cable to the pan/tilt base (Figure 27).  ILRIS-3D boots up.

Figure 27:  Connecting the battery cable to the pan/tilt base

ILRIS-3D is now set up and ready for operation.
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6 POCKET PC OPERATION

About this chapter

This chapter provides the following information:

■ Pocket PC overview‚ page 33
■ Using the Pocket PC Controller‚ page 33
■ Setting up ILRIS-3D at the survey site‚ page 35
■ Configuring Pocket PC network settings‚ page 35
■ Starting the Pocket PC Controller‚ page 42
■ Connecting to the ILRIS-3D scanner‚ page 43
■ Configuring the camera settings‚ page 45
■ Capturing pan/tilt images (option)‚ page 47
■ Defining the region of interest (ROI)‚ page 48
■ Defining your scan settings‚ page 50
■ Starting the scan‚ page 52
■ Monitoring the scan progress‚ page 54
■ Pocket PC Controller software‚ page 56
■ Pan/tilt controls‚ page 60.

Pocket PC 
overview 

The Pocket PC communicates with ILRIS-3D wirelessly, or wired if you prefer, using 
the ILRIS-3D Controller software.  The Controller provides full control of all ILRIS-
3D functions in local mode.  Although you can still use a standard Ethernet cable to 
connect to ILRIS-3D, a wireless connection offers unparalleled flexibility in operator 
control and data collection. 

To set up quickly, you can conveniently operate ILRIS-3D in local mode wirelessly, 
using just the Pocket PC and a USB memory device, at a range of up to 7.6 m (25 
feet).  If you prefer a wired connection, you can use the Ethernet cable to connect 
the Pocket PC to ILRIS-3D.  This ensures a safe and reliable connection and prevents 
communication interference from other devices.

Using the Pocket 
PC Controller

After you have set up ILRIS-3D at the site you want to survey (page 25) and have 
familiarized yourself with the Pocket PC Controller software (page 56), you are 
ready to start using the Pocket PC Controller interface.

ILRIS-3D is typically operated by using the Pocket PC Controller software in a 
sequential process.  When setting up a survey for the first time, read this section 
carefully to become familiar with ILRIS-3D operation before starting a scan.
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This section is divided into nine sub-sections, illustrating in sequence how to use the 
Controller in the field to set up, start and monitor your scan (Figure 28).

Figure 28:  Typical ILRIS-3D workflow using the Pocket PC Controller
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Setting up ILRIS-
3D at the survey 
site

For more information, see "Setting Up at a Survey Site"‚ page 25.

Configuring 
Pocket PC 
network settings 

This section shows you how to configure the Pocket PC’s IP address, and how to 
reset it if necessary (page 40).  You must configure the IP address before starting a 
scan.

Configuring the Pocket PC’s IP address

1. From the Pocket PC start screen, tap Start in the top left corner (Figure 29).  The 
Start pop-up menu appears.

Figure 29:  Pocket PC Start screen, showing the Start button
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2. From the Start pop-up menu, tap Settings (Figure 30).  The Settings window 
appears.

Figure 30:  Accessing the Settings window

3. From the Settings window, tap the Connections tab (Figure 31).  

Figure 31:  Connections tab
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4. From the Connections tab, tap the Network Cards icon (Figure 32).  The 
Configure Wireless Networks window appears.

Figure 32:  Network Cards icon

5. From the Configure Wireless Networks window, tap the Network Adapters tab 
(Figure 33).  The Configure Network Adapters window appears.

Figure 33:  Network Adapters tab
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6. From the Configure Network Adapters window, double-tap Dell Axim X51 
WLAN Wireless Adapter.  The Dell Axim X51 WLAN Wireless Adapter window 
appears.

Figure 34:  Configure Network Adapters window

Figure 35:  Connecting to ILRIS-3D
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7. From the Dell Axim X51 WLAN Wireless Adapter window, select Use specific 
IP address, and type the following to connect to ILRIS-3D (Figure 35):

IP address
10.128.0.X, where X is any number between 1 and 255.

Subnet mask
255.0.0.0.

OR

If your ILRIS-3D is running a previous firmware version, type the following:

IP address
192.168.0.X, where X is any number between 1 and 255 
except the IP address number displayed on the scanner LCD 
panel.

Subnet mask
255.255.255.0.

8. After typing the appropriate IP address, tap OK (Figure 36).  The Adapters 
Message window appears.

Figure 36:  OK button

9. From the Adapters Message window, tap OK again to return to the Settings 
window.  You have now configured the Pocket PC’s IP address.

10. Proceed to the next step, Starting the Pocket PC Controller‚ page 42.

Important    Determining the current firmware version
To determine which firmware your ILRIS-3D is currently 
running, check the wireless IP address on the scanner LCD 
panel:

192.168.0.X:  Earlier firmware version
10.0.X.X:  Latest firmware version.

!
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Resetting the Pocket PC’s IP address

1. Follow steps 1-4 starting on page 35 for Configuring the Pocket PC’s IP address.

2. From the Connections tab, tap the Network Cards icon (Figure 37).  The WLAN 
Utility window appears.

Figure 37:  Network Cards icon

3. From the WLAN Utility window, tap the Turn Off button to reset the IP address. 
The message changes from WLAN ON to WLAN OFF and the WLAN icon dis-
appears, indicating that the wireless adapter has been shut off (Figure 38).

Figure 38:  WLAN Utility, shown ON and OFF
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4. Wait ten seconds, then tap the Turn On button again to turn the wireless 
adapter back on.  The message changes back to WLAN ON, and the Antenna 
icon appears, indicating that the Pocket PC is connected to ILRIS-3D 
(Figure 39).

Figure 39:  Antenna icon, indicating a successful connection

You have now reset the Pocket PC’s IP address.

Important
Turning the wireless adapter on and off forces the Pocket PC to use 
the same IP address that you previously entered.

!
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Starting the 
Pocket PC 
Controller 

1. From the Pocket PC start menu, double-tap the ILRIS-3D Pocket PC Controller 
icon.  The Controller main window appears (Figure 40).

Figure 40:   ILRIS-3D Controller main window

2. Proceed to the next step, Connecting to the ILRIS-3D scanner.
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Connecting to the 
ILRIS-3D scanner 

After configuring your network settings and starting the Controller, you are ready to 
connect to the ILRIS-3D scanner.  To do so, you must first enter the unit’s IP address 
and then ping the scanner (page 44).

Entering ILRIS-3D’s IP address

1. Start the ILRIS-3D Controller software (page 42).

2. Tap File > Connect.  The Wireless Settings window appears.

3. From the drop-down menu, select Wireless (Figure 41).

Figure 41:  Selecting the Wireless IP address

4. Under IP Address, type the address displayed on the ILRIS-3D LCD panel.  All 
new systems with updated firmware versions installed have an IP address 
starting with 10.0.40.X.

5. Tap Save to save the IP address of your unit, so that you do not have to re-enter 
it again.

6. Proceed to the next step, Pinging ILRIS-3D.
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Pinging ILRIS-3D

By pinging ILRIS-3D, you can confirm that the Controller software is communicating 
with the scanner:

1. From the Wireless Settings window, tap the Ping button.  One of the following 
messages appears:

Ping Ok
Connection is present (Figure 42).  Proceed to step 2.

Ping Time Out
No connection.  Tap the Ping button several times to verify no 
connection.  If you still cannot connect, re-connect to ILRIS-3D 
(page 43.

Figure 42:  Ping OK

2. Tap the Connect button to connect to ILRIS-3D.

3. Proceed to the next step, Configuring the camera settings.
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Configuring the 
camera settings 

After connecting to ILRIS-3D, you must configure ILRIS-3D’s camera settings:

1. From the Controller main window, tap Tools > Cameras Settings (Figure 43).  
The Camera Settings window appears.

Figure 43:  Configuring the camera settings

2. Use the drop-down arrow to select the lighting option that best describes the 
environmental conditions, and tap the Set button (Figure 44).

Figure 44:  Adjusting lighting options
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3. Under the White Balance section, tap One Push (Figure 45).

Figure 45:  White Balance, One Push button

4. Tap OK in the top right corner of the window.  The image displayed on the 
ILRIS-3D LCD panel is updated.

5. Proceed to the next step:
■ If you are using the pan/tilt base, proceed to Capturing pan/tilt images 

(option)
■ If you are not, proceed to Defining the region of interest (ROI)‚ page 48.
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Capturing pan/tilt 
images (option) 

After configuring the camera, you are ready to capture the 360° pan/tilt image, if 
you have this option:

1. Tap the Capture Image button.  ILRIS-3D captures images consecutively at 20-
second intervals.  When ILRIS-3D finishes scanning, a 360° image appears, 
similar to the one shown in Figure 46.

Figure 46:  Pan/tilt window

2. Proceed to the next step, Defining the region of interest (ROI).
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Defining the 
region of interest 
(ROI) 

After adjusting the camera and capturing a pan/tilt image (if applicable), you are 
ready to define the ROI:

1. Tap the Capture Image button.  The target image appears in the Camera 
window (Figure 47).

Figure 47:  Target image

2. Tap the Add Box button to add an ROI box (Figure 48).  The ROI defines ILRIS-
3D’s field of view (FOV).

Figure 48:  ROI box, showing capture nodes
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3. Resize, move, add or delete multiple ROIs if desired (page 49).

4. Tap the Next button to proceed to the next step, Defining your scan settings.

Resizing and moving the ROI

1. Double-tap any one of the nodes of the ROI box.  The box is highlighted.

2. To resize the ROI, tap and drag one of the outside nodes.

3. To move the ROI, tap and drag the center node.

Adding multiple ROIs

You can add as many ROIs as you want to cover the desired scanning area.  To add 
another ROI, tap the Add Box.  Figure 49 shows the Camera window after adding 
three ROIs.

Figure 49:  Adding multiple ROIs
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Defining your 
scan settings 

When you click the Next button after defining ROIs, the Scan Settings window 
appears (Figure 50).

Figure 50:  Scan Settings window

To define scan settings

1. Tap the Acquire button to obtain the scan’s mean distance in meters.  The mean 
distance is the average distance between the ILRIS-3D scanner and the scanned 
object.
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2. Adjust the following settings as necessary:

Spot Spacing
Density of the scan.  A small value results in a high-resolution 
scan, and a large value results in a low-resolution scan.

Bounds
Defines the scan using position values;  essentially the same as 
resizing the ROI box.  

3. Tap the Next button.  The Temperature and Voltage window appears 
(Figure 51).  This window displays ILRIS-3D’s current temperature and current 
power consumption.

Figure 51:  Temperature and Voltage window

4. Tap the Next button to proceed to Starting the scan.

Important
Under Information, the estimated time, file size, number of 
points and number of boxes contained in the scan are dis-
played.  They are updated whenever settings change.

!
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Starting the scan After adjusting your scan settings, you are ready to start the scan from the Scan 
window (Figure 52):

Figure 52:  Scan window

1. From the Scan window, tap the Change button to rename your scan.  The File 
Name window appears (Figure 53).

Figure 53:  Naming your scan

2. Use the keyboard to type the new name of your scan, and click OK.  The Scan 
window reappears (Figure 52).
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3. To add user notes, tap the Edit button.  The User Notes window appears 
(Figure 54).

Figure 54:  User Notes window

4. Use the keyboard to type your user notes, and tap OK.  The Scan window 
reappears (Figure 52).

5. Tap the Scan button to start the ILRIS-3D scan.

6. Tap Next to proceed to the next step, Monitoring the scan progress.
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Monitoring the 
scan progress 

After you start the scan, you can monitor its progress from the Scan Progress window 
(Figure 55).  This window displays useful information such as the number of data 
points, estimated scan time and total progress.

Figure 55:  Scan Progress window

At the end of the scan, you can either define a new ROI (page 48) or tap File > Dis-
connect to disconnect from ILRIS-3D.
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Viewing scan progress on the camera image

You can also monitor the progress of the scan by tapping View > Picture Blending.  
When you select this feature, ILRIS-3D intensity data gradually overwrites the 
camera image on the Pocket PC as the scan progresses, as shown in Figure 56.

To reveal the real-time intensity data:

1. Drag the Scan Progress window to the right, and tap the Back button 
(Figure 56).

2. Drag the Scan Progress window down to reveal the active ROI.

Figure 56:  Viewing scan progress on the camera image
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Pocket PC 
Controller 
software

The Pocket PC Controller interface enables you to connect to ILRIS-3D, either wire-
lessly or via an Ethernet data cable.  From the user interface you can define and 
control a scan and set various scan settings, including spot spacing, scan pattern, 
pulse mode and position values.  

The interface is divided into four areas:

■ Menu bar (page 57)
■ Toolbar (page 58)
■ Camera window (page 59)
■ Status window (page 59).

Figure 57:  Pocket PC Controller - main interface

Note
For more information on Controller options and settings, see "PC Opera-
tion"‚ page 59.

!
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Pocket PC Controller menu bar

File menu

Connect
Connects to ILRIS-3D (page 43).

Disconnect
Disconnects from ILRIS-3D.

Edit menu

Delete All ROIs
Deletes all active regions of interest (ROI).

View menu

Picture Blending
Overwrites the camera image with ILRIS-3D intensity data.

Show ROI Sub Regions
Shows/hides the ROI sub regions.

Show Mirror Extents Grid
Shows/hides the mirror extents grid (pan/tilt base only).

Show Pan/Tilt Grid
Shows/hides the pan/tilt grid.

Show Pan/Tilt Window
Shows/hides the Pan/Tilt window (page 60).

Tools menu

Power Settings
Adjusts ILRIS-3D power settings.

Camera Settings
Adjusts ILRIS-3D camera settings (page 45).

Time Settings
Adjusts ILRIS-3D time settings.
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Help menu

About
Displays the current software version number and copyright 
information.

Other options

  Keyboard icon
Accesses Pocket PC keyboard functions.

  Other options
Accesses and changes Controller settings such as the input 
method.

Pocket PC Controller toolbar

The Controller toolbar enables you to accomplish the following quickly:

■ Add a new scan area
■ Delete the active scan area
■ Toggle between multiple scan areas
■ Magnify the camera image display
■ Reduce the camera image display
■ Fit the image in the window
■ Capture the current camera image and download it to the Pocket PC
■ Cancel the current image capture.

Figure 58:  Pocket PC Controller toolbar
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Camera window

The Camera window displays a live video image of the area that ILRIS-3D is 
currently facing.  It is updated or refreshed each time you tap the Capture Image 

button .

Figure 59:  Camera window

Status window and other options

The Status window instantly alerts you to your current connection status.  If you are 
not connected, the Status window displays the message Disconnected.

There are three icons beside the Status window:

  Toolbar button
Shows/hides the Controller toolbar.

  Next button
Proceeds to the next screen.  This button is used for sequential 
operations.
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  Back button
Navigates to the previous screen.  This button is used for 
sequential operations.

Pan/tilt controls To access the Pan and Tilt controls (Figure 60), select View > Show Pan/Tilt 
Window. 

Figure 60:  Pan and Tilt Control window

Pan settings:

  Left button
Pans counter-clockwise 1 increment.

  Right button
Pans clockwise 1 increment.

  Go button
After entering a value in the text box, pans to an absolute value 
between -180° and +180°, with respect to the home position 
(0°).

Tilt settings:

  Up button
Tilts up 1 increment.
60 0040170/Rev A/Nov 06



ILRIS-3D Operation Manual Pocket PC Operation
  Down button
Tilts down 1 increment.

  Orientation button
Sets the orientation of the ILRIS unit on the Pan/Tilt unit.  The 
Up arrow is for upward-tilting configurations, and the Down 
arrow is for downward-tilting configurations.

  Go button
After entering a value in the text box, tilts to an absolute value 
between 0° and +75° (or 0° and -75° for downward configura-
tions), with respect to the home position (0°).

After changing the Pan or Tilt value, the exact position is displayed next to the Go 
button.  You can only change the Pan or Tilt value when "The Pan Tilt System is 
ready" appears (Figure 61).

Figure 61:  Pan Tilt System ready message
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Pan/Tilt overlap settings

To adjust the Pan/Tilt overlap setting, tap Advanced Settings in the Pan and Tilt 
Control window (Figure 60).

Figure 62:  Pan Tilt Overlap Region Size window

Use the drop-down menu to select an overlap percentage between pan increments.  
The resulting number of pan regions and degree overlap value appears with each 
setting.
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7 PC OPERATION

About this chapter

This chapter provides the following information:

■ PC overview‚ page 63
■ Using the PC Controller‚ page 63
■ Setting up ILRIS-3D at the survey site‚ page 65
■ Configuring PC network settings‚ page 65
■ Starting the PC Controller‚ page 69
■ Connecting to the ILRIS-3D scanner‚ page 70
■ Configuring the camera settings‚ page 72
■ Capturing pan/tilt images (option)‚ page 73
■ Defining the region of interest (ROI)‚ page 74
■ Defining your scan settings‚ page 77
■ Starting the scan‚ page 78
■ Monitoring the scan progress‚ page 79
■ PC Controller software‚ page 80.

PC overview Instead of using the Pocket PC to communicate with the ILRIS-3D scanner, you can 
use a laptop computer with the PC Controller software.  As with the Pocket PC, you 
can use a standard Ethernet cable to connect to ILRIS-3D.  However, using a 
wireless LAN connection still offers the most flexibility in operation control and data 
collection.

Using the PC 
Controller

After you have set up ILRIS-3D at the site you want to survey (page 25) and have 
familiarized yourself with the PC Controller interface (page 80), you are ready to 
start using this software.

ILRIS-3D is typically operated by using the PC Controller software in a sequential 
process.  When setting up a survey for the first time, read this section carefully to 
become familiar with ILRIS-3D operation before starting a scan.

This section is divided into ten sequential sections, illustrating how to use the Con-
troller in the field to set up, start and monitor your scan (Figure 63).
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Figure 63:  Typical ILRIS-3D workflow using the PC Controller
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Setting up ILRIS-
3D at the survey 
site

For more information, see "Setting Up at a Survey Site"‚ page 25.

Configuring PC 
network settings 

This section shows you how to configure your LAN card to communicate with 
ILRIS-3D via a wired or wireless connection (page 67).

Configuring network settings for a wired connection

1. Start ILRIS-3D.

2. When ILRIS-3D starts, connect your cross-cable or modem cable to your 
computer.

3. From your desktop, click Start > Settings > Network Connections, or Start > 
Control Panel > Network Connections.  The Network Connections window 
appears (Figure 64).

Figure 64:  Network Connections window
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4. Double-click Local Area Connection.  The Local Area Connection Status 
window appears (Figure 65).

Figure 65:  Local Area Connection Status window

5. From the Local Area Connection Status window, click Properties.  The Local 
Area Connection Properties window appears (Figure 66).

Figure 66:  Local Area Connection Properties window
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6. Double-click Internet Protocol (TCP/IP).  The Internet Protocol (TCP/IP) Proper-
ties window appears (Figure 67).

Figure 67:  Internet Protocol (TCP/IP) Properties window

7. From the Internet Protocol (TCP/IP) Properties window, select Use the following 
IP address.

8. In the IP address field, type 192.9.202.X, where X can be any number from 1-
255 except for 248.

9. Click OK.  Your LAN card is now set up to communicate with ILRIS-3D.

10. Proceed to the next step, Starting the PC Controller‚ page 69.

Configuring network settings for a wireless connection

1. Follow steps 1-6 starting on page 65.

2. From the Internet Protocol (TCP/IP) window (Figure 67), select Use the 
following IP address.

3. In the IP address field, type:
0040170/Rev A/Nov 06 67



PC Operation ILRIS-3D Operation Manual
IP address
10.128.0.X, where X is any number between 1 and 255.

Subnet mask
255.0.0.0.

OR

If your ILRIS-3D is running a previous firmware version, type the following:

IP address
192.168.0.X, where X is any number between 1 and 255 
except the IP address number displayed on the scanner LCD 
panel.

Subnet mask

255.255.255.0.

4. Click OK.  Your LAN card is now set up to communicate with ILRIS-3D.

5. Proceed to the next step, Starting the PC Controller.

Important    Determining the current firmware version
To determine which firmware your ILRIS-3D is currently 
running, check the wireless IP address on the scanner LCD 
panel:

192.168.0.X:  Earlier firmware version
10.0.X.X:  Latest firmware version.

!
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Starting the PC 
Controller  

1. From the desktop, double-click the PC Controller software icon.  The PC Con-
troller main window appears (Figure 68).

Figure 68:  PC Controller main interface

2. Proceed to the next step, Connecting to the ILRIS-3D scanner.
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Connecting to the 
ILRIS-3D scanner 

After starting the PC Controller software, you are ready to connect to the ILRIS-3D 
scanner.  To do so, you must first enter the unit’s IP address:

1. From the Controller interface, select File > Connect.  The Connection Settings 
window appears (Figure 69).

2. From the Connection Settings window, enter the IP address for your ILRIS-3D 
scanner.

Figure 69:  Connection Settings window

The IP addresses for wired and wireless communication are provided on the 
LCD panel of each ILRIS-3D scanner.  Typically the addresses are:

Wired:    192.9.202.248

Wireless:    10.0.40.X, where X is the number shown in the ILRIS-3D LCD 
panel

3. Click Save to save your IP address.

4. Proceed to the next step, Pinging ILRIS-3D.

Pinging ILRIS-3D

By pinging ILRIS-3D, you can confirm that the Controller software is communicating 
with the scanner:

1. From the Connection Settings window, click the Ping button.  One of the 
following messages appears:

Ping Ok
Connection is present (Figure 70).  Proceed to step 2.
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Ping Time Out
No connection.  Tap the Ping button several times to verify no 
connection.  If you still cannot connect, re-connect to ILRIS-3D 
(page 70).

Figure 70:  Ping OK

2. Click the Connect button to connect to ILRIS-3D.

3. Proceed to the next step, Configuring the camera settings.
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Configuring the 
camera settings 

After connecting to ILRIS-3D, you must configure the camera settings:

1. Click Tools > Camera Settings.  The Camera Settings window appears 
(Figure 71).

Figure 71:  Camera Settings window

2. At lower left in the Camera Settings window, use the drop-down arrow to select 
the lighting option that best describes the environmental conditions, and click 
the Set button.

3. Under White Balance, click One Push.

4. Experiment until the image is satisfactory.  The image updates immediately.

5. Click OK to implement your changes, and click Capture Images.

6. Proceed to the next step:
■ If you are using the pan/tilt base, proceed to Capturing pan/tilt images 

(option)
■ If you are not, proceed to Defining the region of interest (ROI)‚ page 74.
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Capturing pan/tilt 
images (option) 

After configuring the camera, you are ready to capture the 360° pan/tilt image, if 
you have purchased this option:

1. Click the Capture Images button.  ILRIS-3D captures images consecutively at 
20-second intervals.  When ILRIS-3D finishes scanning, a 360° image appears, 
similar to the one shown in Figure 72.

Figure 72:  Pan/tilt window

2. Proceed to the next section, Defining the region of interest (ROI).
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Defining the 
region of interest 
(ROI) 

After you have adjusted the camera and pan/tilt base (if applicable), you are ready to 
start the scan:

1. Click the Capture Images button.  The target image appears in the Camera 
window (Figure 73).

Figure 73:  Target image
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2. Click the Add button to add an ROI box (Figure 74).  The ROI defines the ILRIS-
3D’s field of view (FOV).

Figure 74:  ROI box, showing capture nodes

3. Resize, move, add or delete multiple ROIs as desired (page 75).

4. Proceed to the next step, Defining your scan settings.

Resizing and moving the ROI

1. Double-click any one of the nodes of the ROI box.  The box is highlighted 
green.

2. To resize the ROI, click and drag one of the outside nodes.

3. To move the ROI, click and drag the center node.
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Adding multiple ROIs

You can add as many ROIs as you want to cover the desired scanning area.  To add 
another ROI, click the Add button.  Figure 75 shows the Camera window after 
adding three ROIs.

Figure 75:  Adding multiple ROIs
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Defining your 
scan settings 

1. Define the scan settings, using the General area in the top-right corner of 
screen.  There are four main settings:

Mean Distance
Average distance between the scanner and the scanned object.

Spot Spacing
Density of the scan.  A small value produces a high-resolution 
scan, and a large value produces a low-resolution scan.

Bounds
Defines the scan area by using position values rather than 
clicking on the scan box.

Information
Summarizes the proposed scan, showing the estimated time, 
file size, number of data points and number of ROIs.

Figure 76:  General window (scan settings)

2. Proceed to the next section, Starting the scan.
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Starting the scan After adjusting your scan settings, you are ready to start the scan:

1. On your desktop or another convenient location, create a folder for the survey.

2. On the Controller interface, click the Options button at bottom right.  The Scan 
Options box appears (Figure 77).

Figure 77:  Scan Options window

3. Browse to the folder you have created for the survey data, and check Save 
Locally.  Survey data is saved automatically to your local directory.

4. Choose other save options as needed:

Save to Scanner
Saves survey data to the scanner USB drive.

Sync
Copies the local filename to the scanner USB drive filename.

Figure 78:  Setting save options in the Scan Options window

5. Click OK to close the Scan Options window.

6. Click the large Scan button to start the ILRIS-3D scan.

7. Proceed to the next section, Monitoring the scan progress.
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Monitoring the 
scan progress 

After you start the scan, you can monitor its progress from the Scan Progress window 
(Figure 79).  This window displays useful information such as the number of data 
points, estimated scan time and total progress.

Figure 79:  Monitoring the scan progress

At the end of the scan, you can either define a new ROI (page 74) or select File > 
Disconnect to disconnect from ILRIS-3D.

Viewing scan progress on the camera image

You can also monitor the progress of the scan by right-clicking in the camera 
window and selecting Picture Blending.  When you select this feature, ILRIS-3D 
intensity data gradually overwrites the camera image as the scan progresses.
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PC Controller 
software

The ILRIS-3D PC Controller enables you to connect to ILRIS-3D in the same way 
you would using the Pocket PC – either wirelessly or via an Ethernet data cable.  
From the PC interface, you can define and control a scan and set various scan 
settings, including spot spacing, scan pattern, pulse mode and position values.

Figure 80:  PC Controller - main interface
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PC Controller 
menu bar

File menu

Connect
Opens the Connection Settings window so that you can 
connect to the ILRIS-3D scanner (page 93).

Disconnect
Disconnects the Controller from the scanner.  (To close and 
exit the Controller, click the X button at top right of the Con-
troller screen.)

Edit menu

Delete all ROIs
Deletes all ROIs on the image.  You can add new ROIs at any 
time.

View menu

Show Pan Tilt Window
Opens the Pan and Tilt Control window (page 94).  The pan/tilt 
base is an ILRIS-3D option.

Show Camera Window
Shows live video from the camera (page 96).

Show ROI Properties Window
Opens the Region of Interest Properties window (page 89).

Tools menu

Power Settings
Opens the Power Settings window (not available).

Camera Settings
Opens the Camera Settings window (page 97).

Time Settings
Opens the Scanner Time Settings window (page 98).

Interface Settings
Opens the Interface Settings window (page 98).
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Camera window This area displays the image from the ILRIS-3D scanner’s internal camera.  The 
image appears only after:

■ Controller and scanner are connected
■ Scanner has captured an image (page 74).

To configure the display, right-click in the camera window.  A drop-down menu 
appears (Figure 81).

Figure 81:  Camera image dropdown menu

Image drop-down menu options

Zoom In, Out (+, -)
Zoom the image in/out.  You can also click the button below 
the image.

Fit To View
Fit the entire image in the pane.  You can also click the Fit 
button below the image.

Picture Blending (pan/tilt option)
Turns picture blending on and off.  For information, see  
"Understanding display settings for the pan/tilt option"‚ 
page 83.

Show Pan/Tilt Grid (pan/tilt option)
Outlines the ten image segments captured by ILRIS-3D with 
the pan/tilt option.

Show Mirror Extents Grid (pan/tilt option)
Outlines the full area captured by ILRIS-3D at each pan 
position.

Show ROI Sub Regions (pan/tilt option)
If the ROI covers more than one pan/tilt position, outlines the 
scan area within the ROI at each pan position.

Capture
Captures the displayed image region only.
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Save
Saves an image region to any location.

Clear
Clears the selected region from the display.  

Understanding display settings for the pan/tilt option

The pan/tilt base enables ILRIS-3D to capture a complete 360° image of the survey 
scene by capturing ten separate 36° segments.  The scanner pans to a new position 
for each segment.  When you display the pan/tilt grid, each segment is clearly 
outlined on the image (Figure 82, top).

Each segment actually has a full field of view of 40°, with 2° at each side overlap-
ping with contiguous scans.  The full extent of a segment is shown on the image 
when you display the mirror extents (Figure 82, bottom).

ILRIS-3D presents the image with all overlap areas blended, to improve the quality 
and continuity between segments.  This Picture Blending feature smooths the 
overlap between segments.  You can turn this feature on and off.  For an illustration 
of the effect at close range, see Figure 84, page 85.

When you define a region of interest (ROI), ILRIS-3D divides that ROI into sub-
regions according to which scan segment they fall into.  If the ROI is completely 
contained within a single scan segment, there is only one sub-region;  if the ROI 
cuts across scan segments, it has two or more sub-regions.  In this case, ILRIS-3D 
scans the first sub-region, and then pans the scanner to scan the second sub-region.  
Sub-regions are identified in the Region of Interest Properties window (page 92).  
You can also display these sub-regions (Figure 83, page 84).
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Figure 82:  Pan/tilt grid (top), and with mirror grid overlaid (bottom), showing 
overlap area between vertical lines

Figure 83:  ROI (top) and ROI divided into scan sub-regions according to mirror 
extents (bottom)
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Figure 84:  ROI overlap with Picture Blending off (left) and on (right)

Status Messages 
pane

This area displays standard, warning and error messages from the ILRIS-3D scanner.

To select how many messages to display, click the Message Log Options button to 
open the Log Message Options window (page 100).  All messages are written to the 
scan log file.

To clear all messages from the screen, click the Clear button.
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Hardware status 
pane

Figure 85:  Scanner temperature and battery display

This area displays the status of two important scanner hardware elements:

Temperature
Displays the internal temperature of the scanner:

Blue
Scanner is too cold.  It must be warmed up before 
operation.

Green
Scanner is within normal operating temperature range.

Yellow
Scanner is approaching overheating.  Consider cooling 
the scanner.

Red
Scanner is too hot for operation.  The scanner will shut 
down if it is not cooled off.

Battery
Displays the battery charge available for the scanner.   

Scan properties 
pane

Figure 86:  Scan properties pane

This area displays scan information including the number of data points in the scan, 
estimated scan time, file location, and user notes.
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To specify the location of the scan data file (USB memory device or computer), click 
the Change button to open the Scan Options window (page 100).

To record user notes regarding the scan, click Edit (page 101).

To start scanning the scene, after defining all ROIs and setting all options, click the 
Scan button.

ROI definition 
pane

Figure 87:  ROI definition pane

This area below the image enables you to do the following:

■ Capture scanner images (and abort the capture)
■ Display different segments of the image at different zoom levels
■ Add, delete and move through all ROIs.

This area includes pan/tilt controls at lower right, which are explained on page 94.

ROI definition options

Zoom buttons
+, -

Zooms in to an image (+) or out from an image (-).

Fit
Fits an entire image or region in the image pane.

Capture Images
Captures an image from the ILRIS-3D scanner, and displays the 
image on-screen.  If the pan/tilt base is attached, a 360° image 
is captured.

Abort Capture
Aborts an image capture.  No image is displayed on-screen.

Add
Adds a new ROI.  The ROI box appears on-screen.  You can 
click and drag to move and resize the box, or enter coordinates 
("Bounds options"‚ page 91).
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Delete
Deletes the most recent ROI.  Click repeatedly to delete all 
ROIs.

Next
Selects the next ROI, in order of creation.

Previous
Selects the previous ROI, in order of creation.

Status bar

Figure 88:  Status bar

This area displays the position of the mouse pointer on the image as XY and theta/
phi coordinates.
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Region of Interest 
Properties 
window

Figure 89:  Region of Interest Properties window

The ROI Properties window open automatically when you capture an image, but it 
is blank until you add an ROI.  When you add or select an ROI, the following infor-
mation appears:

■ General options‚ page 89
■ Step Stare Pattern options‚ page 90
■ Bounds options‚ page 91
■ Scan information area‚ page 92.

General options

Figure 90:  General scan options

This area enables you to determine the approximate range to the target, and the lidar 
pulse mode for the scan.  If you do not know the range, you can instruct the ILRIS-
3D scanner to acquire it.
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This area has the following options:

Mean Distance
Mean distance to the target in the ROI.  Enter a range in meters, 
or click Acquire to acquire the distance automatically.

Acquire
Quickly scans the target area, and displays the average range 
under Mean Distance.

Pulse Mode
Sets the lidar operating mode:

First
For good visibility.  Determines the range by 
measuring the first pulse returning to the scanner.

Last
For dust, fog, rain or snow.  Determines the range by 
measuring the last return pulse, filtering out earlier 
returns.

Step Stare Pattern options

Figure 91:  Step Stare Pattern options

This area defines the scan density for an ROI.  It has the following options:

X, Y Spot Spacing
Horizontal spacing between laser shots, or vertical spacing 
between scan lines, in degrees or millimeters.  Lower values 
produce higher-resolution scans.  That is, a value of 10 
produces more laser spots per scan, or more scan lines, than a 
value of 20.

Enter a value, or drag the slider bar to the desired value.
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Allow Rect. Gridding
Allows horizontal and vertical spot spacing to be set indepen-
dently, producing a rectangular grid rather than a square.

Bounds options

Figure 92:  Bounds options

This area displays the boundaries of an ROI.  It enables you to define an ROI by 
entering position coordinates instead of clicking and dragging an ROI box on the 
screen.

Boundaries are displayed in degrees as follows:

Top, Bottom extents of the ROI
0° is the bottom of the image.

Left, Right extents of the ROI
0° is the middle of the image.

To set a new position, enter a coordinate in the text box.
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Scan information 
area

Figure 93:  Scan information display

This area summarizes the scan information for an ROI.  Review this information to 
determine how long a scan will take and how much data it will produce.

This area displays the following information:

Est Scan Time
Estimated time to scan an ROI, including all sub-regions.

Est Data Size
Estimated size of a scan data file.

Est Data Points
Estimated number of laser shots (data points) in an ROI.

Virtual ROI ID
Task number assigned automatically by the scanner to each 
ROI.  This number appears in the Parser as well.

Number of ILRIS ROIs
Number of sub-regions in an ROI (pan/tilt option).

Virtual Rectangle Bounds
Top left and lower right XY coordinates of an ROI.

Sub ROI Regions
Text box that displays information for each sub-region.  To 
display information, click the button next to each sub-region 
number (pan/tilt option).
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Connection 
Settings window

Figure 94:  Connection Settings window, showing Ethernet and Wireless settings

To open the Connection Settings window, select File > Connect from the main 
menu.  This window enables you to do the following:

■ Set the connection mode, Ethernet or wireless
■ Set the IP address and port for the connection
■ Ping the IP address to check the connection.

Connection Settings options

Connection Type
Type of connection to the ILRIS-3D scanner:

Ethernet
Connects to the scanner via Ethernet.  An Ethernet 
card and serial data cable are required.

Wireless
Connects to the scanner via wireless communication.

IP Address
IP address to use for the scanner connection.  The IP addresses 
for Ethernet and wireless communication are provided on the 
display panel of your ILRIS-3D scanner.  Typical addresses are:

Ethernet
192.9.202.248

Wireless
10.0.40.X, where X is the number shown in the ILRIS-
3D LCD panel
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Port
Port through which to access the IP address.  The default port is 
1039, but you can set other ports as necessary.

Ping button
Pings the scanner to test the connection.

Ping OK
Scanner and Controller are communicating.

Ping timeout
No communication between scanner and Controller.

Save
Saves your settings as the default.  Use this button the first time 
you use the Controller, or whenever settings change.

Cancel
Closes the window without connecting to the scanner.

Connect
Connects to the scanner and closes the window.

Pan and Tilt 
Control window

Figure 95:  Pan and Tilt Control window

To open this window, select View > Show Pan Tilt Window from the main menu.

If the pan/tilt option is installed, this window enables you to do the following:

■ Set the amount by which to pan and tilt the scanner between scans
■ Move the scanner to the next scan position
■ Switch the scanner orientation on the pan/tilt base.

Pan and Tilt Control options

Pan angle dial
Displays the current pan position of the scanner, where the top 
is the initial scanner position (Figure 95).
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Left, Right
Moves the scanner left or right by one pan position or by the 
angle displayed in the text box.

Pan angle text box
Specifies the angle by which to pan the scanner left or right, in 
degrees.

Go
Pans the scanner as specified.

Tilt angle dial
Displays the current tilt position of the scanner, where level is 
the initial scanner position (Figure 95).

Up, Down
Tilts the scanner from fully raised (75°) to level (0°), or up and 
down by the angle displayed in the text box.

Tilt angle text box
Specifies the angle by which to tilt the scanner up or down, in 
degrees from 0° to 75° (or 0° to -75° for the downward config-
uration).

Go
Tilts the scanner as specified.

  Orientation button
Toggles the orientation of the scanner on the pan/tilt base.  The 
Controller understands that the scanner is reversed, scanning 
backwards and down, and adjusts position coordinates to 
match.  A message appears, warning you that new images must 
be captured.

Advanced Settings
Opens the Advanced Pan Tilt Setting window (Figure 96).  This 
setting affects the Overlap Region Size.  You can choose 
between 5%, 12.5%, and 20% overlap.  The resulting number 
of pan regions and degrees of overlap appear.
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Figure 96:  Advanced Pan Tilt Settings

If the pan/tilt base is not attached to the scanner, the following message appears at 
the bottom of the window:

The Pan Tilt System is unavailable.

Camera View To show live video from the ILRIS-3D caneram select View > Show Camera 
Window.

Figure 97:  Camera View window
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Camera Settings 
Window

Figure 98:  Camera Settings window

The Camera Settings window enables you to adjust the camera image.  The image 
may appear initially over- or under-exposed (very light or very dark).  To adjust the 
image:

1. Select Tools > Camera Settings.  The Camera Settings window appears 
(Figure 98).

2. At lower left in the Camera Settings window, use the drop-down arrow to select 
the lighting option that best describes the environmental conditions, and click 
the Set button.

3. Under White Balance, click the One Push button.

4. Check the camera image, and change the setting until the image is satisfactory.

To understand and use other settings in this window, consult photographic 
reference documentation.
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Scanner Time 
Settings window

Figure 99:  Scanner Time Settings window

The Scanner Time Settings window enables you to set the date and time for the 
scanner clock.

To open this window, select Tools > Time Settings from the main menu.  The 
window has the following options:

Date
Current date, in the format month/day/year.

Time
Current time.

Interface Settings 
window

Figure 100:  Interface Settings and Color Selection windows
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The Interface Settings window enables you to do the following:

■ Set the ROI width and handle size
■ Modify the colors assigned to image and ROI elements.

To open this window, select Tools > Interface Settings from the main menu.

Interface Settings options

Some settings are only available with the pan/tilt option.  For information on sub-
regions and mirror grids, see "Understanding display settings for the pan/tilt option"‚ 
page 83.

ROI Line Width
Width of the border of the ROI, from 1 to 10.  The default is 1.

ROI Handle Size
Size of the grab bars for the ROI, from 1 to 15.  The default is 5.

Normal
Border color for all ROIs on the image.

Selected
Border color for a selected ROI.

Sub Region 1, 2
Border color for each ROI sub-region.

Sub Region 1, 2 Selected
Border color for a selected ROI sub-region.

Pan Tilt Grid
Border color for the pan/tilt grid.

Mirror Grid 1, 2
Border color for the mirror grids.

Modify button
Opens the Color Selection window (Figure 100, right) so that 
you can modify the default color for image and ROI elements.

Default
Resets all image and ROI color assignments to their default 
values.
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Log Message 
Options window

Figure 101:  Log Message Options window

The Log Message Options window enables you to specify the number of messages 
to display in the Status Messages window.  All messages are saved to the scan log 
file.

To open this window, click the Message Log Options button in the Controller.  The 
window has the following options:

Number of Messages to Display
Number of messages to display under Status Messages.  The 
default number is 50.  If the scanner sends more than 50 
messages, earlier messages are erased but they are still saved to 
the scan log file.

Scan Options 
window

Figure 102:  Scan Options window

The Scan Options window enables you to do the following:

■ Specify where to save scan data
■ Specify the name of the scan.

To open this window, click the Options button at bottom right in the Controller.  
The window has the following options:
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Save Locally
Saves scan data to your computer.  Enter the folder name, or 
click Browse to choose the folder.

Save To Scanner
Saves scan data to the scanner.  The default scan name is 
Scan1, Scan2 and so on.  Accept the default, or enter a new 
name with a maximum of 28 characters.

Sync
Saves scan data to the USB memory device in the scanner, 
using the same name as Save To Scanner.

User Notes 
Window

To records notes about your scan, click the Edit button in the Controller.  The User 
Notes window appears (Figure 103).

Figure 103:  User Notes window
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8 PARSER OPERATION

About this chapter

This chapter provides the following information:

■ Parser overview‚ page 103
■ Using the Parser software‚ page 105
■ Starting the Parser software‚ page 106
■ Loading data‚ page 107
■ Advanced Parser settings‚ page 109
■ Selecting your data outputs‚ page 113
■ Parsing your data‚ page 114
■ Exiting the Parser‚ page 114
■ Parser interface‚ page 115
■ Parser Settings window‚ page 121
■ Output File properties‚ page 123
■ Color Channel properties‚ page 129
■ Shot Correction settings‚ page 130
■ Shot Alignment and Reduction properties‚ page 131
■ Pan Tilt Transform properties‚ page 134
■ Miscellaneous‚ page 135.

Parser overview Parser operations occur after survey operation, when you download and pre-process 
the survey data.  The ILRIS-3D Parser is used after a survey to:

■ Process the *.i3d  metafiles of survey scans
■ Output data files that are suitable for PolyWorks (PIF) format or standard 

GIS or modeling software.

The Parser is designed to make it quick and easy for you to parse and re-parse data 
again and again, trying out new settings each time.

The Parser processes a compressed metafile with the extension *.i3d.  This metafile 
contains the following information, written to memory during the scan:

■ Binary file of the scan data
■ Scan settings and operator notes (operator log)
■ Image file of the survey scene.
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The Parser’s main features are:

■ Several output formats
■ Range gate and intensity gate
■ Data reduction, to reduce the data density and overall file size.

The Parser outputs:

■ Data file
■ Various graphical outputs such as bitmaps (option)
■ Text file of scan settings, operator notes and Parser settings (option).
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Using the Parser 
software

After you have finished scanning a scene and have familiarized yourself with the 
Parser software (page 115), you are ready to start using the Parser software.

The Parser software is typically used sequentially in one of two ways, as shown in 
Figure 104:

■ Load Data >  Select Data Outputs >  Parse Data
■ Load Data >  Set Up Advanced Settings > Select Data Outputs > Parse Data.

Figure 104:  Typical Parser software workflow

This section of the manual is divided into five sequential sections, showing you how 
to parse your collected data from start to finish.  Each section also shows you where 
you are in the Parser software workflow.  For example, if you are in the Starting the 
Parser software section, that box is highlighted.

LOAD DATA

SELECT DATA OUTPUTS
(XYZ/PIF FILE)

PARSE DATA

YES

PARSE DATA?

SET UP ADVANCED
SETTINGS (COLOR

CHANNEL, TRIM DATA
SHOTS, ETC.)

NO

LAUNCH ILRIS-3D
PARSER SOFTWARE
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Starting the 
Parser software 

1. Double-click the Parser icon on your desktop.  The Parser main screen appears 
(Figure 105).

Figure 105:  Parser main screen

2. Proceed to the next step, Loading data.

LOAD DATA

SELECT DATA OUTPUTS
(XYZ/PIF FILE)

PARSE DATA

YES

PARSE DATA?

SET UP ADVANCED
SETTINGS (COLOR

CHANNEL, TRIM DATA
SHOTS, ETC.)

NO

START THE ILRIS-3D
PARSER SOFTWARE
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Loading data After starting the Parser software, you are ready to load data or a scan for parsing:

1. Click File > Load > Scan Project.  The Browse For Folder window opens 
(Figure 106).

Figure 106:  Browse For Folder window

LOAD DATA

SELECT DATA OUTPUTS
(XYZ/PIF FILE)

PARSE DATA

YES

PARSE DATA?

SET UP ADVANCED
SETTINGS (COLOR

CHANNEL, TRIM DATA
SHOTS, ETC.)

NO

START THE ILRIS-3D
PARSER SOFTWARE
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2. Select the folder that contains the scan data:

a. Browse to the folder.

b. Select the folder, and click OK.  The JPEG image of the scan scene appears 
in the image area of the Parser main screen (Figure 107).

Figure 107:  Image area

3. Proceed to the next step, Parsing your data (page 114), or set advanced settings.
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Advanced Parser 
settings 

After you have loaded your scan project, you can choose to parse the data 
(page 114) or to set up advanced settings, including the color channel and trimming 
of data shots:

1. Open the Parser Settings window in one of the following ways:
■ From the menu bar, click Settings > Parsing Settings
■ Click the Settings button under Scan Window Properties.

The Parser Settings window opens (Figure 108).

Figure 108:  Parser Settings window

2. Proceed to the next step, Setting up the color channel.

LOAD DATA

SELECT DATA OUTPUTS
(XYZ/PIF FILE)

PARSE DATA

YES

PARSE DATA?

SET UP ADVANCED
SETTINGS (COLOR

CHANNEL, TRIM DATA
SHOTS, ETC.)

NO

START THE ILRIS-3D
PARSER SOFTWARE
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Setting up the color channel

1. From the Parser Settings window, click Color Channel in the left pane, or select 
Settings > Color Channel from the main screen.  The Color Channels options 
appear (Figure 109).

Figure 109:  Color Channel settings

2. Check Use External Texture and Parameter File.

3. Insert the ILRIS-3D Product CD in your CD-ROM or DVD-ROM drive.
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4. From the CD, browse for the calib_1.txt file in the Camera Calibration 
folder.  The text file appears under Texture Calibration Parameter File.

Figure 110:  Locating the calib_1.txt file

5. Click Open > OK.

6. Choose whether to:
■ Parse data by clicking the Parse Data button (page 114)
■ Adjust the shot alignment and reduce the number of shots (page 112).
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Adjusting the shot alignment and reducing the number of shots

1. From the Parser Settings window, click Shot Alignment & Reduction in the left 
pane.  The shot options appear in the right pane.

2. Under Shot Alignment, check Trim Shots (Figure 111).

3. Use the up/down arrows beside Points to Trim to select how many shots to trim.

Figure 111:  Shot Alignment & Reduction settings

4. Under Shot Reduction Factors, use the up/down arrows to trim shots horizon-
tally or vertically.

5. (Option)  Click Save Preferences to make your new settings the default settings.

6. Click Apply > OK to apply your settings to the scan.  If you do not, your settings 
will be discarded.

7. Proceed to the next step, Selecting your data outputs.
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Selecting your 
data outputs 

After you have adjusted your advanced scan settings, you are ready to select your 
data outputs:

1. Under Scan Window Properties, click the Settings button.  The Parser Settings 
window appears (Figure 112).

Figure 112:  Output Settings

2. Select your output file format under Output File Format.  PIF, XYZ and IXF files 
are the most typical formats.

3. Click Apply > OK.

4. Proceed to the next step, Parsing your data.

LOAD DATA

SELECT DATA OUTPUTS
(XYZ/PIF FILE)

PARSE DATA

YES

PARSE DATA?

SET UP ADVANCED
SETTINGS (COLOR

CHANNEL, TRIM DATA
SHOTS, ETC.)

NO

START THE ILRIS-3D
PARSER SOFTWARE
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Parsing your data After you have selected your output file, you are ready to parse your data:

1. From the menu bar, click Process > Parse, or click the Parse button under Scan 
Window Properties.  Parsing begins immediately.

2. Monitor the Parser screen for progress messages and error codes.  To stop the 
parsing, click Cancel in the Parsing Messages window (Figure 113).

Figure 113:  Parsing Messages window

Parsing takes only a few seconds.  When parsing is complete, data is written to 
the output sub-folder.  You can now check parsing results, re-parse the scan or 
exit the Parser.

Repeating parsing with different settings  

You can re-parse the same scan data with the same or different settings as often as 
you want.  To re-parse a scan, follow the same steps as for the initial scan.

You can now check parsing results or exit the Parser.

Exiting the Parser To exit the RGB Parser at the end of a session:

■ Click the X in the top right corner of the Parser main screen.

You can now proceed to check parsing results and process the scan data with CAD, 
GIS or other modeling software.

LOAD DATA

SELECT DATA OUTPUTS
(XYZ/PIF FILE)

PARSE DATA

YES

PARSE DATA?

SET UP ADVANCED
SETTINGS (COLOR

CHANNEL, TRIM DATA
SHOTS, ETC.)

NO

START THE ILRIS-3D
PARSER SOFTWARE

Note    Overwriting files
If you parse a scan twice using the same output format, the Parser over-
writes the results of the first scan.  To preserve earlier parsing results, 
select Output File and create a new output folder.

!
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Parser interface The Parser interface consists of the Parser main screen and a separate Parser Settings 
window.  The main screen is divided into six areas, as shown in Figure 114:

■ Menu bar (page 116)
■ Toolbar (page 117)
■ Image area (page 118)
■ Scan Window Properties (page 119)
■ Input File window
■ Scan options area.

Figure 114:  Parser main screen
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Parser menu bar

File menu

Load 
Loads scan data for parsing:

Single Data File
Loads a single data file (not available).

Scan Project
Loads scan data from a project folder.

Exit
Exits and closes the Parser (not available).  To exit the Parser, 
click the X button in the top right corner of the Parser interface.

Settings menu

Parser Settings
Opens the Parser Settings window.

Color Channel
Displays the color channel properties in the Parser Settings 
window.

Process menu

Parse
Parses the selected scan with the specified Parser settings.  You 
can also click the Parse button under Scan Window Properties, 
or the Parse icon.

Help menu

About
Opens the About Parser information window.
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Parser toolbar

The Parser toolbar allows you to quickly accomplish the following:

■ Open a scan project
■ Open the Parser Settings window
■ Display the color channel properties
■ Parse a scan project
■ Open Parser help.

Figure 115:  Parser toolbar
0040170/Rev A/Nov 06 117



Parser Operation ILRIS-3D Operation Manual
Image area

Figure 116:  Parser interface, with image area highlighted

The image area displays the scan scene and all regions of interest (ROI) for that 
scene.  The default image is captured by ILRIS-3D’s internal camera, but you can 
select another image instead.

When you click inside an ROI:

■ Borders change to green
■ Scan properties are displayed at right until you select another ROI.
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Scan Window Properties

Figure 117:  Parser interface, with Scan Window Properties highlighted

The Scan Window Properties area, at right on the Parser interface, displays the prop-
erties of the currently selected ROI.  Properties can be viewed but not changed.

To display the properties for an ROI, click in the ROI.

Scan Window Properties displays the following information:

Task ID
Unique number that is assigned automatically by the ILRIS-3D 
scanner to each ROI.

No. of Shots
Number of laser shots in a scan.

No. of Scan Lines
Number of horizontal lines in a scan.

Points per Line
Number of laser shots in a scan line.
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Scan Pattern
Type of scan pattern used for a scan.  The default is Step Stare 
(see "Step stare"‚ page 145).

Start Point (deg)
Start point for a scan, where the first value is degrees X from 
the center of the image, and the second value is degrees Y from 
the center.

Stop Point (deg)
Stop point for a scan, where the first value is degrees X from 
the center of the image, and the second value is degrees Y from 
the center.

Spot Spacing (h, count)
Horizontal data density, the space between each laser shot in a 
scan line, in encoder counts.  A higher number increases the 
spacing between shots, and reduces the data density.

Spot Spacing (v, count)
Vertical data density, the space between each scan line, in 
encoder counts.  A higher number increases the spacing 
between shots, and reduces the data density.
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Parser Settings 
window

Figure 118:  Parser Settings window

The Parser Settings window enables you to specify the following properties:

■ Output file (page 123)
■ Color channel (page 129)
■ Shot Correction (page 130)
■ Shot alignment and reduction (page 131).
■ Pantilt Transform (page 134)
■ Miscellaneous (page 135).

Command buttons and the selection area at left always remain the same, but the 
area at right changes depending on your selection.
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Parser Settings command buttons

Figure 119:  Parser Settings window command buttons

The Parser Settings window has the following command buttons:

Save Preferences
Saves your settings as default preferences.  Use this button the 
first time you use the Parser, or whenever settings change.

Apply
Applies your settings to the current scan.

OK
Closes the Parser Settings window.  If you do not click Apply, 
your settings are discarded.

Cancel
Closes the Parser Settings window without applying your 
settings.
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Output File prop-
erties

Figure 120:  Output file properties

The output file window enables you to select the format of parsed data, and which 
information to include in the output file.

To display these properties, select Output File at left in the Parser Settings window.

The output file has the following properties:

Output Folder
Location of the folder for all parsing files.  The default is a sub-
folder of the project folder.

To select another folder, enter the location or click the  
button at right to browse to the location.

Output File Format
Output format for the parsed data.  The Parser currently 
supports 11 formats (page 124).  New formats are added regu-
larly.
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Output options area
Parsing options and data to include in the output file.  Proper-
ties are available for the following formats:

■ PIF, page 125

■ XYZ, page 126

■ Raw, page 127

■ PTC, page 127.

Output file formats

The Parser supports the following output formats:

PIF
PolyWorks binary format.

XYZ
Standard ASCII text file with X, Y, Z and I (intensity) in a right-
hand coordinate system, in meters.  To set XYZ output proper-
ties, see page 126.

Raw
ASCII text file of raw scanner encoder counts for azimuth angle 
(theta), elevation angle (phi), slant range and intensity data (x 
100).  Used mainly for debugging and troubleshooting.  To set 
Raw output properties, see page 127.

PTX
Leica exchange format.

3DV
XYZ input file with shot ordering (row, column) specified, 
saved in PIF coordinate system.  Native to 3D Veritas.

BWP
BitWyse format.

S3D
SIAMS S3D format.

PTC
ASCII point cloud format that is similar to XYZ format.  To set 
PTC output properties, see page 127.

BLF
BitWyse laser format.

IVA
Same as PTX format, except that XYZ+intensity data is saved in 
.3lf format.

IXF
ILRIS Exchange Format.  Binary file format that improves data 
sharing among third-party applications and data sources.  To 
set Raw output properties, see page 128.
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PIF output options

Figure 121:  PIF output properties

You can include the following options in the PIF output file:

None
Intensity data is not provided in the output file.

8-bit Scaled
(Default)  Includes a scaled intensity value for each data point 
in the output file.  This value is output as an 8-bit grayscale.

24-bit Texture (RGB)
Includes intensity data as separate color values (0-255) for R, G 
and B.  This option is only useful if your processing software 
uses RGB.
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XYZ output options

Figure 122:  XYZ output options

You can include the following options in the XYZ output file:

X (Easting)
Horizontal value in meters from the scanner center.

Y (Northing)
Vertical value in meters from the scanner center.

Z (Up)
Range value in meters from the scanner center.

Intensity
Intensity value (IR) from 0 to 255 (saturated).

8-bit scaled
(Default)  Includes a scaled intensity value for each 
data point in the output file.  This value is output as an 
8-bit grayscale.

texture
Includes intensity data as separate color values (0-255) 
for R, G and B.  This option is only useful if your pro-
cessing software uses RGB.
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Raw output options

Figure 123:  Raw output options

You can include the following options in the RAW output file:

Theta (azimuth angle)
X horizontal value in scanner X encoder counts from the 
scanner center.

Phi (elevation angle)
Y vertical value in scanner Y encoder counts from the scanner 
center.

Range
Range value in meters from the scanner center.

Intensity
Intensity value from 0 to 255 (saturated).

Shot Flag
Dropout, saturation and low/high gain status of each laser shot, 
represented by a hexadecimal shot flag.

PTC output options

Figure 124:  PTC output options

You can include the following options in the PTC output file:

None
Intensity data is not provided in the output file.
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8-bit Scaled
(Default)  Includes a scaled intensity value for each data point 
in the output file.  This value is output as an 8-bit grayscale.

24-bit Texture (RGB)
Includes intensity data as separate color values (0-255) for R, G 
and B.  This option is only useful if your processing software 
uses RGB.

IXF output options

Figure 125:  PTC output options

You can include the following options in the PTC output file:

None
Intensity data is not provided in the output file.

8-bit Scaled
(Default)  Includes a scaled intensity value for each data point 
in the output file.  This value is output as an 8-bit grayscale.

24-bit Texture (RGB)
Includes intensity data as separate color values (0-255) for R, G 
and B.  This option is only useful if your processing software 
uses RGB.
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Color Channel 
properties

Figure 126:  Color channel properties

The color channel window enables you to select an image to merge with the scan 
data, and to select the calibration file for the camera that captured that image.  
Unless you check Use External Texture & Parameter File, the Parser uses the default 
image and calibration files.

To display these properties, click the    icon, or select Color Channel at left in the 
Parser Settings window, or select Settings > Color Channel from the main window.

The color channel has the following properties:

Task ID
Unique number that is assigned automatically by the ILRIS-3D 
scanner to each ROI.

Use External Texture & Parameter File
Check to specify an image and calibration file other than the 
default.  

Texture Image File
Location of the 2D JPEG image of the scan scene.  The 
filename of the ILRIS-3D camera image appears automatically.

To select an external image, check Use External Texture & 
Parameter File, and enter the filename or click the button at 
right to browse to the location.
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Texture Calibration Parameter File
Location of the camera calibration file for the selected image.  
The default file is stored on your computer.

To select an external calibration file, check Use External 
Texture & Parameter File, and enter the filename or click the 
button at right to browse to the location.

Shot Correction 
settings

The Shot Correction setting is a smoothing algorithm.  Select Shot Correction > 
Smoothing from the left pane of the Parser Settings window (Figure 127).

Figure 127:  Smoothing window

Smoothing has the following properties:

No. of Iterations
Number of smoothing passes.

Tolerance
Tolerance of the smoothing algorithm, in mm.
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Half Window Size
Set the number of points to include in the smoothing calcula-
tion.

Algorithm Type

Vertical
Smooth in the vertical direction.

Horizontal
Smooth in the horizontal direction.

Shot Alignment 
and Reduction 
properties

Figure 128:  Shot alignment and reduction properties

The shot alignment and reduction window enables you to tailor the selection of 
laser shots for parsing.  This can be useful if you want to:

■ Reduce the overall data density
■ Trim extra laser shots at the edge of the scan, where the scanner changes 

direction.  This maintains an even distribution of data points throughout the 
scan.

To display shot properties, select Shot Alignment & Reduction at left in the Parser 
Settings window.
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Shot alignment and reduction has the following properties:

Shot Alignment

Trim Shots
Trims leading and trailing data points at the edge of the scan, to 
simplify point cloud triangulation or surface modeling.  Rec-
ommended.

Points to Trim
Sets the number of points to trim.  The default is 5.  

Shot Reduction Factors
Sets the factor by which to reduce the overall density of scan 
laser shots.  The default is 1 (no reduction).

As shown in Figure 129, a value of 2 for Horizontal and 
Vertical actually reduces the number of laser shots that are 
parsed by a factor of 4:  that is, every second shot is removed 
horizontally and every second scan line is removed vertically.

Figure 129:  Effect of applying horizontal and vertical shot reduction factors of 1

Notice
Trimming too many points may reduce the overlap 
between scans.

!
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Horizontal
Reduces the number of laser shots that are parsed in each scan 
line by the selected factor.  For example, selecting 3 removes 1 
shot in 3.

Vertical
Reduces the number of scan lines that are parsed by the 
selected factor.  For example, selecting 3 removes 1 scan line 
in 3.

Selection of Output Points

Keep Dropout Readings
Keeps readings from laser shots that did not return to the 
scanner (for example, from the sky) in the output file.  Always 
select this option for gridded outputs such as PIF.

Keep Saturated Readings
Keeps readings with an intensity value that exceeds 255 (for 
example, from a retro-reflector) in the output file.  Always 
select this option for gridded outputs such as PIF.

Remove Outliers
Removes laser shots with ranges that differ from those of sur-
rounding shots by more than a preset amount.
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Pan Tilt Transform 
properties

Figure 130:  Pan Tilt Transform settings

Pan Tilt Transform has the following properties:

Apply Pan-tilt Transform
Sets the scan in the correct Pan Tilt position.

Apply Pan-tilt Model Parameters
Use the correction file to compensate for Pan Tilt errors.

How ILRIS unit is mounted on pantilt platform

Automatically determined from scan file
Uses the orientation saved in the scan log file.

ILRIS unit looks FORWARD on pantilt platform
Forces the transform to use the forward (tilt up) orientation.

ILRIS unit looks DOWNWARD on pantilt platform
Forces the transform to use the downward (tilt down) orienta-
tion.
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Miscellaneous

Miscallaneous has the following setting:

Move Origin of Cartesian Coordiate System to Bolt Hole
Moves the system origin to the bottom of the bolt hole.
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9 MAINTENANCE AND SUPPORT

About this chapter

This chapter provides the following information:

■ Recharging batteries‚ page 137
■ Cleaning screens and windows‚ page 142
■ Annual calibration‚ page 142
■ Storage‚ page 143
■ Warranty‚ page 143
■ Customer support‚ page 144
■ Returning equipment to Optech‚ page 144.

To order ILRIS-3D parts and replace consumable items, see "Customer support"‚ 
page 144.

Recharging 
batteries

The ILRIS-3D scanner is normally powered by two or four high-capacity batteries.  
For information on the batteries, see page 24.  This section discusses the following:

■ Status indicators on the charger (page 138)
■ Status indicators on the battery (page 139)
■ To recharge batteries (page 139)
■ To replace the battery fuse (page 141).

The battery charger holds two batteries, or four with an optional dual expansion 
module.  However, only one battery is charged at a time.  It takes approximately 2-4 
hours to fully recharge a pair of batteries.

Always check the battery charge:

■ Before going to the survey site
■ After setting up ILRIS-3D, but before beginning the survey.

To check the battery charge, look at the display on the battery (Figure 132, 
page 139).

Notice
Charge batteries fully between surveys, to ensure that they are always 
charged and ready for use.

!
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Status indicators on the charger

The status of each charger position is shown on the display panel, and by two status 
LEDs below the display panel, as shown in Figure 132 and Table 3.

Figure 131:  Battery charger with two batteries installed

Table 3:  Charger status indicators

Indicator Display Explanation

Display Panel WAIT Battery is waiting to be charged

CHARGE Battery is charging

READY Battery is recharged

HOLD See battery charger manual

Status LED Red/green flashing Evaluating battery

Red flashing Recharge battery

Red solid Battery is waiting to be charged

Green solid Battery is recharged
138 0040170/Rev A/Nov 06



ILRIS-3D Operation Manual Maintenance and Support
Status indicators on the battery

The battery has two charge indicators:  the display panel (Figure 132) and the 
CHARGE STATUS LED on the base of the battery.  If this LED is green, the battery 
is fully charged.

Figure 132:  Battery charge status display (from manufacturer’s manual)

To recharge batteries

3. Place the battery on the charger so that the slots and pins on the battery fit into 
the studs and grooves on the charger (Figure 135, page 141).

4. Press the rocker switch projecting from the charger, and slide the battery in 
towards the center of the charger.

5. Release the switch.  The battery is now installed.

6. Plug the charger into a suitable power outlet.

7. Charge the batteries until READY appears on the charger display.
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Figure 133:  Battery base components

Figure 134:  Battery charger, showing mounting positions and rocker switches
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Figure 135:  Slotting battery studs into charger slots

To replace the battery fuse

As shown in Figure 134, page 140, there is a fuse on the back of the battery as well 
as a spare fuse.  To replace the fuse:

1. Use a screwdriver or coin to pop up the black plastic fuse holder, and remove 
the holder. 

2. Replace the fuse with a new fuse.

3. Re-install the fuse holder.
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Cleaning screens 
and windows

The ILRIS-3D scanner includes windows/screens that need occasional cleaning.  
Clean these elements as follows:

Front scan and camera windows - precision Schott glass with optical coating
These windows are very delicate.  Do not scratch or rub.  
Clean with lens tissue as described in "To clean the front scan/
camera windows"‚ page 142.

Rear operator display screen - scratch-resistant Lexan MR10
Clean with lens tissue and a mild, non-abrasive cleaner.

Cleaning supplies

1 Bottle of Fischer Scientific (A 454-4) methanol or equivalent

1 Pair of latex gloves

1 Box of lens-cleaning tissue

1 Can of Airjet spray or equivalent

To clean the front scan/camera windows

1. Using the Airjet spray, remove and blow all large particles from the window.

2. Place one piece of lens tissue on the scanner window.

3. Saturate the lens tissue with methanol.

4. Lightly draw the lens-cleaning tissue across the window in a smooth, sweeping 
motion.  Do not scratch or rub the window.

Annual calibra-
tion

Optech recommends that you return your scanner annually for inspection and cali-
bration.  For more information, contact your Optech representative.
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Storage Always store the scanner and other ILRIS-3D equipment in the carry case.  Store the 
case in a clean, dry environment between -20°C and +50°C, and keep the lid closed 
to prevent moisture or dirt from entering.

For information on battery storage, see the battery manuals provided.

When removing the scanner from storage

When the scanner is removed from cool storage to a warm environment, the tem-
perature difference may cause condensation inside the unit.  For these reasons:

■ Before powering on, let the scanner warm up and acclimatize for up to 60 
minutes

■ Before powering on, check that scanner windows are free from condensa-
tion

■ After powering on, let the scanner warm up before scanning for 10 minutes.

Warranty This product is warranted to be free from defects in materials, parts and workman-
ship for a period of one year from the date of delivery.  It will conform to the current 
product specifications upon delivery.  Misuse, improper handling, unauthorized 
repairs or modifications, or use of the system outside of specifications will void this 
warranty.

Unauthorized opening of the scanner will void this warranty.
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Customer support Optech is committed to customer satisfaction.  Please direct all ILRIS-3D questions 
and comments to: 

Third-party software

Optional software packages are available with ILRIS-3D.  If you require support for 
registration, dongles, licenses and upgrades, contact your Optech representative.

Software upgrades

The ILRIS-3D Controller and Parser are Optech products.  All ILRIS-3D users are 
notified of upgrades to this software as they become available.

Third-party software may be included with your ILRIS-3D.  Because software 
upgrades and technical support are available to registered users, remember to 
register these products.

Returning 
equipment to 
Optech

To return equipment, contact Customer Support to obtain a Return Material Authori-
zation number (RMA).  Optech will not accept equipment without this number.

ILRIS-3D Customer Support
Optech Incorporated
300 Intercange Way
Vaughan, Ontario Canada L4K 5Z8

Telephone:
E-mail:
Website:

1-905-660-0808 (8 a.m. to 5 p.m. local time)
ilris3d_support@optech.ca
www.optech.ca
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APPENDIX A:  GLOSSARY

This appendix briefly defines common terms used in ILRIS-3D documentation.

 Intensity
Reflectance of a scanned surface, from 0 to 255 (saturated).  
This value can be scaled and output as an 8-bit grayscale, or 
provided as separate RGB values.

Lidar
Light distance and ranging.  A technique that uses laser pulses 
to measure ranges.

Pan/tilt
Optional scanner base that pans the scanner horizontally and 
vertically, providing a series of 360° scans at different eleva-
tions.

Point cloud
Raw 3D digitized data represented by a point for each data 
point.

Region of interest (ROI)
Operator-defined area of the survey scene that is scanned by 
ILRIS-3D.  ROIs are outlined on the scanner display in high-
contrast red.

ROI
Region of interest.

Scan
Single operator-programmed scan.

Scan area, scan area box, pick box, target area
Region of interest (ROI).  

Scanner center, 0,0,0
Point at which the scanner range measurement begins.  This 
point is selected as the bottom of the screw hole in the base of 
the ILRIS-3D scanner.

Step stare
Default scan pattern for the ILRIS-3D scanner.  The scanner 
scans horizontally, then "steps" to the next scan line and scans 
back across the region of interest.

Survey
Series of scans of a particular site or area.
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Survey project
Survey of 1 or more individual scans.

Survey scene
Entire scene shown on the ILRIS-3D scanner display.

Task ID
Task identification number assigned by the ILRIS-3D scanner to 
every scan.  This number appears in the Parser and the parsing 
log file.
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APPENDIX B:  ERROR CODES

Parser error 
codes

Parser error messages are displayed as a hexadecimal code in a separate error 
window.  The following error codes may be displayed:

-0x01
Failed to open file.  Make sure that the file is not being used by 
other software, and try again.

-0x02
Failed to read file.  Make sure that the file is not being used by 
other software, and try again.

-0x03
Failed to write file.  Make sure that the file is not being used by 
other software, and try again.

-0x04
Failed to write file in right order.  Try again.

-0x05
Unknown camera image type.

-0x06
Unsupported camera image format.

-0x07
Camera image is not a 24-bit color image.

-0x08
Unsupported file format.

-0x09
Failed to find scan data.  File may be corrupted.

-0x0A
Unsupported multi-box scan data file.

-0x0B
Failed to create new folder.

-0x0C
Scan folder has no scan data file.

-0x0D
Folder contents incomplete.  Data files may be missing.  Check 
folder contents and try again.

-0x11
Failed to create object.  Memory may be low.  Try again.

-0x12
Insufficient memory available.

-0x13
Failed to register controls (for example, graph plotter controls).

-0x21
Invalid data ID.
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-0x22
Data ID cannot be processed.

-0x23
Invalid number.

-0x24
Invalid reference ASC.  ASC will not be applied.

-0x25
Invalid collected ASC.  ASC will not be applied.

-0x26
Incorrect version number.

-0x27
.hdr file is corrupted.

-0x28
.hdr file is corrupted.

-0x29
.hdr file is corrupted.

-0x2A
.blk file is corrupted.

-0x2B
.blk file is corrupted.

-0x2C
.blk file is corrupted.

-0x2D
.hdr file is corrupted.

-0x41
.blk file is corrupted.

-0x42
.blk file is corrupted.

-0x43
.blk file is corrupted.

-0x51
Unknown shot type.  The .blk file is corrupted.

-0x52
Unknown ASC type.  ASC will not be applied.

-0x53
Unsupported camera image format.

-0x54
Unknown intensity type.

-0x55
Unknown ASC type.  ASC will not be applied.

-0x56
Camera images are of different size.  Image may not display 
properly.

-0x57
Not enough ASC data.  ASC will not be applied.
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-0x61
Unknown parsing model (converting polar data to Cartesian XYZ).

-0x62
Unknown smoothing algorithm type.

-0x71
Number of points per line is too low to trim shots.

-0x81
Error in internal data storage.  Try again.

-0x82
Error in internal data storage.  Try again.

-0x91
Internal synchronization.

-0xFFFFFF
Unknown error.  Try again.
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